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1.  INTRODUCTION

The Jackrabbit is a high-performance, C-programmable single-

board computer with a compact form factor. A Rabbit® 2000

microprocessor operating at 29.5 MHz provides fast data pro-

cessing.

1.1  Features

• 29.5 MHz clock

• 24 CMOS-compatible I/O

• 3 analog channels: 1 A/D input, 2 PWM D/A outputs

• 4 high-power outputs (factory-configured as 3 sinking and 1 sourcing)

• 4 serial ports (2 RS-232 or 1 RS-232 with RTS/CTS, 1 RS-485, and 1 CMOS-

compatible)

• 6 timers (five 8-bit timers and one 10-bit timer)

• 128K SRAM, 256K flash EPROM

• Real-time clock

• Watchdog supervisor

• Voltage regulator

• Backup battery
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Three Jackrabbit models are available. Their standard features are summarized in Table 1.

Throughout this manual, the term Jackrabbit refers to all three Jackrabbit models in 

Table 1; individual models are referred to specifically according to the model number in 

Table 1.

Appendix A provides detailed specifications.

1.2  Development and Evaluation Tools

A complete Development Kit, including a Prototyping Board and Dynamic C develop-

ment software, is available for the Jackrabbit. The Development Kit puts together the 

essentials you need to design an embedded microprocessor-based system rapidly and effi-

ciently.

Table 1.  Jackrabbit Features

Model Features

BL1800 Full-featured controller with switching voltage regulator.

BL1810

BL1800 with 14.74 MHz clock, 128K flash EPROM, linear 

voltage regulator, sinking outputs sink up to 200 mA, 

sourcing output sources up to 100 mA, RS-232 serial ports 

rated for 1 kV ESD

BL1820
BL1810 with 3 additional digital I/O, no RS-485, no 

backup battery.

Visit the Web site for up-to-date information about additional add-ons and features as 

they become available. The Web site also has the latest revision of this user’s manual.
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1.3  How to Use This Manual

This user’s manual is intended to give users detailed information on the Jackrabbit. It does 

not contain detailed information on the Dynamic C development environment or the Rabbit 

2000® microprocessor. Most users will want more detailed information on some or all of 

these topics in order to put the Jackrabbit to effective use.

1.3.1  Additional Product Information

In addition to the product-specific information contained in the Jackrabbit (BL1800) 

User’s Manual (this manual), several higher level reference manuals are provided in 

HTML and PDF form on the accompanying CD-ROM. Advanced users will find these 

references valuable in developing systems based on the Jackrabbit:

• Dynamic C User’s Manual

• Dynamic C Function Reference Manual

• Rabbit 2000 Microprocessor User’s Manual

1.3.2  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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1.4  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequen-

cies above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-

based systems at frequencies above 300 MHz are generally well below background noise 

levels.

The Jackrabbit single-board computer has been tested and was found to 

be in conformity with the following applicable immunity and emission 

standards. The BL1810 and BL1820 single-board models are also CE 

qualified as they are sub-versions of the Jackrabbit. Boards that are CE-

compliant have the CE mark.

NOTE: Earlier versions of the Jackrabbit sold before 2002 that do not have the CE mark 

are not CE-complaint.

Immunity

The Jackrabbit series of single-board computers meets the following EN55024/1998 

immunity standards.

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The Jackrabbit series of single-board computers meets the following emission standards 

with the Rabbit 2000 spectrum spreader turned on and set to the normal mode. The spectrum 

spreader is only available with Rev. C or higher of the Rabbit 2000 microprocessor. This 

microprocessor is used in all Jackrabbit series boards that carry the CE mark.

• EN55022:1998 Class B

• FCC Part 15 Class B 

In order for the Jackrabbit boards to meet these EN55022:1998 Class B standards, you 

must add ferrite absorbers to the serial I/O cables used for RS-232 and RS-485 serial com-

munication. Depending on your application, you may need to add ferrite absorbers to the 

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m
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digital I/O cables. Your results may vary, depending on your application, so additional 

shielding or filtering may be needed to maintain the Class B emission qualification.

NOTE: If no ferrite absorbers are fitted, the Jackrabbit boards will still meet 

EN55022:1998 Class A requirements as long as the spectrum spreader is turned on.

The spectrum spreader is on by default for Jackrabbit models BL1810 and BL1820. The 

spectrum spreader is off by default for the Jackrabbit model BL1800, and must be turned 

on with at least one wait state in order for the BL1800 model to be CE-compliant. 

Section 3.8.3 provides further information about the spectrum spreader and its use, and 

includes information on how to add a wait state.

1.4.1  Design Guidelines

Note the following requirements for incorporating the Jackrabbit series of single-board 

computers into your application to comply with CE requirements.

General

• The power supply provided with the Development Kit is for development purposes 

only. It is the customer’s responsibility to provide a CE-compliant power supply for the 

end-product application.

• When connecting the Jackrabbit single-board computer to outdoor cables, the customer 

is responsible for providing CE-approved surge/lightning protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices. Rabbit also recommends using properly shielded I/O cables in noisy 

electromagnetic environments.

• When installing or servicing the Jackrabbit, it is the responsibility of the end-user to use 

proper ESD precautions to prevent ESD damage to the Jackrabbit. 

Safety

• For personal safety, all inputs and outputs to and from the Jackrabbit series of single-

board computers must not be connected to voltages exceeding SELV levels (42.4 V AC 

peak, or 60 V DC). Damage to the Rabbit 2000 microprocessor may result if voltages 

outside the design range of 0 V to 5.5 V DC are applied directly to any of its digital 

inputs.

• The lithium backup battery circuit on the Jackrabbit single-board computer has been 

designed to protect the battery from hazardous conditions such as reverse charging and 

excessive current flows. Do not disable the safety features of the design.

1.4.2  Interfacing the Jackrabbit to Other Devices

Since the Jackrabbit series of single-board computers is designed to be connected to other 

devices, good EMC practices should be followed to ensure compliance. CE compliance is 

ultimately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our Web site at www.rabbit.com.
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2.  GETTING STARTED

This chapter describes the Jackrabbit board in more detail, and

explains how to set up and use the accompanying Prototyping

Board.

NOTE: This chapter (and this manual) assume that you have the Jackrabbit Development 

Kit. If you purchased a Jackrabbit board by itself, you will have to adapt the informa-

tion in this chapter and elsewhere to your test and development setup.

2.1  Development Kit Contents

The Jackrabbit Development Kit contains the following items:

• BL1810 single-board computer.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., 

U.K., and European style plugs). If you are using another power supply, it must provide 

7.5–25 V DC at 5 W.

NOTE: The linear voltage regulator becomes rather hot for voltages above 15 V.

• 10-pin header to DB9 programming cable with integrated level-matching circuitry.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Getting Started instructions.

• A bag of accessory parts for use on the Prototyping Board.

• Screwdriver.

• Rabbit 2000 Processor Easy Reference poster.

• Registration card.
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2.2  Development Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the 

sample programs:

1. Attach the Jackrabbit to the Prototyping Board.

2. Connect the programming cable between the Jackrabbit and the workstation PC.

3. Connect the power supply to the Jackrabbit.
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2.2.1  Attach Jackrabbit to Prototyping Board

To attach the Jackrabbit board to the Prototyping Board, turn the Jackrabbit board over so 

that the battery is facing up. Plug the pins from headers J4 and J5 on the bottom side of the 

Jackrabbit board into the header sockets at J2 and J6 on the Prototyping Board as indicated 

in Figure 1.

Figure 1.  Attach Jackrabbit Board to Prototyping Board

NOTE: It is important that you line up the pins on headers J4 and J5 of the Jackrabbit 

board exactly with the corresponding pins of header sockets J2 and J6 on the Prototyp-

ing Board. The header pins may become bent or damaged if the pin alignment is offset, 

and the Jackrabbit might not work. Permanent electrical damage to the may also result 

if a misaligned Jackrabbit is powered up.

Press the Jackrabbit’s pins firmly into the Prototyping Board headers.
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2.2.2  Connect Programming Cable

The programming cable connects the Jackrabbit to the PC running Dynamic C to down-

load programs and to monitor the Jackrabbit during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J3 on 

the Jackrabbit board as shown in Figure 2. Be sure to orient the marked (usually red) edge 

of the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used 

for a normal serial connection.)

NOTE: Use only the programming cable that has a red shrink wrap around the RS-232 

level converter (Part No. 20-101-0513), which is supplied with the Development Kit. 

Other Rabbit programming cables are not voltage-compatible or their connector sizes 

may be different.

Figure 2.  Power and Programming Cable Connections

to Jackrabbit Board

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. 

Carefully pull on the connector to remove it from the header.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use 

an RS-232/USB converter (Part No. 20-151-0178) with the programming cable sup-

plied with the Jackrabbit Development Kit. Note that not all RS-232/USB converters 

work with Dynamic C.
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2.2.3  Connect Power

When all other connections have been made, you can connect power to the Jackrabbit.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 

The Jackrabbit Development Kit presently includes Canada/Japan/U.S., Australia/N.Z., 

U.K., and European style plugs. Snap in the top of the plug assembly into the slot at the 

top of the AC adapter as shown in Figure 2, then press down on the spring-loaded clip 

below the plug assembly to allow the plug assembly to click into place.

Hook up the connector from the AC adapter to header J1 on the Jackrabbit board as shown 

in Figure 2. The orientation of this connector is not important since the VIN (positive) 

voltage is the middle pin, and GND is available on both ends of the three-pin header J1.

Plug in the AC adapter. The Jackrabbit board and the Prototyping Board are ready to be 

used.

NOTE: A RESET button is provided on the Prototyping Board (see Figure 1) to allow 

hardware reset without disconnecting power.

To power down the Jackrabbit, unplug the power connector from J1. You should discon-

nect power before making any circuit adjustments in the prototyping area, changing any 

connections to the board, or removing the Jackrabbit from the Prototyping Board.
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2.3  Installing Dynamic C

If you have not yet installed Dynamic C, do so now by inserting the Dynamic C CD from 

the Jackrabbit Development Kit in your PC’s CD-ROM drive. The CD will auto-install 

unless you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and 

browse for the Dynamic C setup.exe file on your CD drive. Click OK to begin the 

installation once you have selected the setup.exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-

lation of the later version will be in a different folder, and a separate icon will appear on 

your desktop.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing 

Dynamic C. The modules may be installed in any order. You must install the modules in 

the same directory where Dynamic C was installed.
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2.4  Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming 

connections by running a sample program. Start Dynamic C by double-clicking on the 

Dynamic C icon on your desktop or in your Start menu. Dynamic C uses the serial port 

specified during installation.

If you are using a USB port to connect your computer to the BL1810, click on the Commu-

nications tab and verify that Use USB to Serial Converter is selected to support the USB 

programming cable. Click OK.You may have to determine which COM port was assigned to 

the RS-232/USB converter. Open Control Panel > System > Hardware > Device Man-

ager > Ports and identify which COM port is used for the USB connection. In Dynamic C, 

select Options > Project Options, then select this COM port on the Communications 

tab, then click OK. You may type the COM port number followed by Enter on your com-

puter keyboard if the COM port number is outside the range on the dropdown menu.

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, 

open it with the File menu, compile it using the Compile menu, and then run it by selecting 

Run in the Run menu. The STDIO window will open on your PC and will display a small 

square bouncing around in a box. This program shows that the CPU is working.

2.4.1  Troubleshooting

If Dynamic C cannot find the target system (error message "No Rabbit Processor 

Detected."):

• Check that the BL1810 is powered correctly — the AC adapter should be connected to 

header J1 on the Jackrabbit board and should be plugged in to a wall outlet.

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and that the PROG connector, not the DIAG connector, is plugged in to the 

programming port on the BL1810 with the colored side lined up with pin 1.

• Ensure that the BL1810 is firmly and correctly installed in its sockets on the Prototyp-

ing Board.

• Select a different COM port within Dynamic C. From the Options menu, select 

Project Options, then select another COM port from the list on the Communications 

tab, then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud rate. 

Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Choose a lower debug baud rate, then click OK.
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2.5  Where Do I Go From Here?

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in Section 4.2 to get a basic familiarity with 

Dynamic C and the Jackrabbit’s capabilities.

2. For further development, refer to this Jackrabbit (BL1800) User’s Manual for details 

of the board’s hardware components.

A documentation icon should have been installed on your workstation’s desktop; click 

on it to reach the documentation menu. You can create a new desktop icon that points to 

default.htm in the docs folder in the Dynamic C installation folder.

3. For advanced development topics, refer to the Dynamic C User’s Manual, also in the 

online documentation set.

2.5.1  Real-Time Clock

If you plan to use the real-time clock functionality in your application, you will need to set 

the real-time clock. You may set the real-time clock using the SETRTCKB.C sample pro-

gram from the Dynamic C SAMPLES\RTCLOCK folder. The RTC_TEST.C sample pro-

gram in the Dynamic C SAMPLES\RTCLOCK folder provides additional examples of how 

to read and set the real-time clock

2.5.2  Technical Support

NOTE: If you purchased your Jackrabbit through a distributor or through a Rabbit partner, 

contact the distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.
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3.  SUBSYSTEMS

Chapter 3 describes the principal subsystems and their use for

the Jackrabbit.

• Digital Inputs/Outputs

• A/D Converter

• D/A Converters

• Serial Communication

• Memory

Figure 3 shows these Rabbit-based subsystems designed into the Jackrabbit.

Figure 3.  Jackrabbit Subsystems


��


�����

���
��
���

	�����
���


�����

��

����

����

�
��	�

�
����

�������

 !�"!��

�����
��#$%
 !�"!��

�%��%�&&�'�
��%�

�������

('"!��

�)�

*�'+$%�$%

�'����

 !�"!��



16 Jackrabbit (BL1800)

3.1  Jackrabbit Pinouts

Figure 4 shows the pinout for headers J4 and J5, which carry the signals associated with 

the Jackrabbit subsystems.

Figure 4.  Pinout for Jackrabbit Headers J4 and J5

3.1.1  Headers

Standard Jackrabbit models are equipped with two 2 × 20 IDC headers (J4 and J5) with a 

2 mm pitch.
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3.2  Digital Inputs/Outputs

3.2.1  Digital Inputs

The Jackrabbit has six CMOS-level digital inputs, PB0–PB5, each of which is pulled up to 

+5 V as shown in Figure 5. The BL1820, which does not have RS-485, has one additional 

CMOS-level digital input, PC1.

Figure 5.  Digital Inputs

The actual switching threshold is approximately 2.40 V. Anything below this value is a 

logic 0, and anything above is a logic 1.

NOTE: Since the voltage limits on the inputs to the Rabbit 2000 microprocessor are 0 to 

5.5 V DC, the end user must ensure that the voltage applied to any I/O pin is within 

these limits.
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3.2.2  Digital Outputs

The Jackrabbit has four CMOS-level digital outputs, PB6–PB7, PCLK, and IOBEN. Four 

high-power outputs, HV0–HV3, are also available—HV0–HV2 can each sink up to 1 A 

(200 mA for the BL1810 and BL1820) at 30 V, and HV3 can source up to 500 mA (100 mA 

for the BL1810 and BL1820) at 30 V. The BL1820, which does not have RS-485, has one 

additional CMOS-level digital output, PC0.

Figure 6.  Jackrabbit High-Power Digital Outputs

The common power supply for the four high-power outputs is called K, and is available on 

header J4. Connect K to the power supply that powers the load, which is usually a separate 

power supply to that used for the Jackrabbit, and must be no more than 30 V because of 

the power limitations of the resistors used in the sourcing output circuit.

The K connection performs two functions.

1. K supplies power to the sinking/sourcing transistors used in the high-power circuits.

2. A diode-capacitor combination in the circuit “snubs” voltage transients when inductive 

loads such as relays and solenoids are driven.
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3.2.2.1  Configurable High-Power Output (HV3)

HV3, shown schematically in Figure 7, is factory-configured to be a sourcing output.

Figure 7.  Configurable High-Current Output

When used as a sourcing output, HV3 is switched to K when PE3 on the Rabbit 2000 goes 

high, and the two transistors shown in Figure 7 are turned on. The maximum sourcing cur-

rent is 100 mA (BL1810 and BL1820) or 500 mA (BL1800), and the maximum K is 30 V. 

This voltage limit on K arises because R51 and R52 at the base of Q28 can each dissipate 

500 mW for a total of 1 W. The 30 V limit then constrains the sinking outputs as well 

because K is common to all four high-current outputs.
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HV3 can also be reconfigured as a sinking output. To do so, remove the 0 Ω surface-

mounted resistor R56, and solder on a 0 Ω surface-mounted resistor or jumper wire at 

R55. If you plan to drive inductive loads, add a diode at D21. Figure 8 shows the location 

of these components.

Figure 8.  Changing HV3 to a Sinking Output

3.2.3  Bidirectional I/O

The Jackrabbit has 14 CMOS-level bidirectional I/O: PA0–PA7, PD0, PD3, PD6–PD7, 

and PE4–PE5. The BL1820, which does not have RS-485, has one additional bidirectional 

I/O, PD5.
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3.3  A/D Converter

The analog-to-digital (A/D) converter, shown in Figure 9, compares the DA0 voltage to 

AD0, the voltage presented to the converter. DA0 therefore cannot be used for the digital-

to-analog (D/A) converter when the A/D converter is being used.

Figure 9.  Schematic Diagram of A/D Converter

The A/D converter transforms the voltage at DA0 into a 20 mV window centered around 

DA0. For example, if DA0 is 2.0 V, the window in the A/D converter would be 1.990 V to 

2.010 V. If AD0 > 2.010 V, PE7 would read high and PE6 would read low. If 1.990 V < 

AD0 < 2.010 V, PE7 would read low and PE6 would read low. This is the case when the 

A/D input is exactly the same as DA0. If AD0 < 1.990 V, PE7 would read low and PE6 

would read high.

PE6 can be imagined to be a “DA0 voltage is too high” indicator. If DA0 is larger than the 

analog voltage presented at AD0, then PE6 will be true (high). If this happens, the pro-

gram will need to reduce the DA0 voltage.

PE7 can be imagined to be a “DA0 voltage is too low” indicator. If DA0 is smaller than 

the analog voltage presented at AD0, then PE7 will be true (high). If this happens, the pro-

gram will need to raise the DA0 voltage.

The A/D input, AD0, is the same as DA0 only when PE6 and PE7 are low. Because the 

A/D converter circuit uses a 20 mV window, the accuracy is ±10 mV. DA0 can range from 

0.1 V to 2.8 V, which represents 270 steps of ±10 mV. This is better than 8-bit accuracy. 

Since the D/A converter is able to change the DA0 output in 3.88 mV steps, there are 697 

steps over the range from 0.1 V to 2.8 V. This represents a resolution of more than 9 bits. 
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